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. This document is designed to help guide you in all
|ntl‘0d UCtIOn applications of the World Wheelchair Rugby brand.
It is a set of guidelines and rules that if applied correctly,
will help maintain the integrity and consistency of all
World Wheelchair Rugby communications.



Our Brand

World Wheelchair Rugby is not your typical
Para sport. It's a high impact, competitive,
contact sport that's not for the faint of heart.

Brand Vision Brand Value Core Be I f Brand Personality
To become a world leader in Para sport. PaSS|on, incl athlete foc Our p p ng bec of its Determined, competitive, e
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Tone of Voice

We're a governing body. But we are athletes
ourselves. We speak with knowledge and
passion. We use the correct terminology for
the sport itself as well as the athletes living
with disabilities.

Voice 1: Governing Body
This is the governing body portion of our voice.
It is accurate and informative.

We want to make sure we present WWR as a
professional organization so that people instantly
recognize it as the authority in sport.

We are informative

We use the correct terminology
We are approachable

We are enthusiastic

Use this voice for: updates, announcements,
scores and standings

Voice 2: Here to Win

This is the passionate portion of our voice.

It reflects the sentiment that wheelchair rugby is
not for the faint of heart and that we play to win.

We want to demonstrate that this sportisn't
inspirational because it features people living
with disabilities, it's inspirational because of its
intense athleticism.

e We are bold

e We are matter of fact

e We aren't afraid to play up the full contact
aspect of the sport

Use this voice for brand-focused messaging.

The term ‘Murderball’ has been removed
from our messaging.

We realize that wheelchair rugby may still be referred
to as 'Murderball' in the mainstream media as well as
social media (i.e. hashtags). As we are a professional

governing body, we will respond as such. We'll

explain as needed that even though we are proud of
our heritage, the term no longer reflects who we are

as a globally-renowned Para sport.



Reporting on Persons with a Disability

In general, it is helpful to remember that
disability is a characteristic or a situation
of life but does not replace life itself.
Life very often proves to be stronger
than any kind of disability.



Reporting on Persons with a Disability

When speaking, interviewing or socializing
with a person or an athlete with a disability,
here are a few general rules to remember:

¢ Always identify the person first and then the
disability. Sometimes it may not be necessary
or relevant to the article to mention the disability,
so don't feel obliged to do so. When it is relevant,

just mention what the disability is and then move on.

e Act naturally and don't monitor every word and
action. Don't be embarrassed if you use common
expressions like “see you later” (to a person with
a visual impairment) or “I'd better run along”

(to someone who uses a wheelchair).

¢ Avoid using emotional wording like “tragic”,
“afflicted”, “victim”, or “confined to a wheelchair”.
Emphasize the ability and not the limitation, ie, by
saying that someone “uses a wheelchair” rather
than “is confined" or “is wheelchair-bound”.

Avoid portraying people with a disability who
succeed as “extraordinary” or “superhuman’”.
For example, overstating the achievements of
athletes with a disability inadvertently suggests
the original expectations were not high.

Portray the person as he/she/they is in real life.

For example, a person with a disability might be an
athlete but he/she/they may also be a parent, a civil
engineer, a doctor, a business manager or a journalist.

People do not want to be recipients of charity
or pity. Remember that a person with a disability
isn't necessarily chronically sick or unhealthy.

When talking with a person who has a disability,
speak directly to that person rather than a
companion or interpreter.

Always ask a person with a disability if he/she/they
would like assistance before rushing in. Your help may
not be needed. However, it is quite all right to offer
help. If your assistance is needed then listen or ask
for instructions.

Don't forget that people with a disability may need
your patience and sufficient time to act independently.
Give the person extra time to speak if they are using

a communication aid or have a learning disability.

Ask persons with a disability to repeat themselves
if you do not understand them.

Respect the person’s personal space and remember
that a wheelchair is part of a person’s personal space.



Reporting on Persons with a Disability

Appropriate Words and Phrases

Avoid

Use

Avoid

Use

Disabled athlete/person
Handicapped athlete/person
Athlete/person with disabilities

Athlete/person with a disability or
Paralympian Place the athlete or person
first rather than referring to his or

her disability.

Abnormal, subnormal, defective,
deformed — These are negative terms
which imply failure to reach personal
perfection

Specify the disability

The handicapped or The physically People with a physical disability Cripple or crippled — These words convey  Able bodied athletes

handicapped a negative image of a twisted ugly body

Normal athletes Able bodied athletes Disease (when used as equal to Say disability
disability) — Many disabilities, such as

A paraplegic, paraplegics A person with paraplegia cerebral palsy and spinal injuries, are
not caused by any illness or disease

A quadriplegic, quadriplegics, quad, A person with quadriplegia

tetraplegic or tetraplegia Stumps — This has the connotations that Say amputation

The blind Persons with a visual impairment

or blindness
Aretard/the retarded A person with an intellectual disability
Spastic A person with cerebral palsy

Afflicted with — Most people with
a disability don't see themselves
as afflicted

Say the person has... (the disability)

Confined to a wheelchair — A wheelchair
provides mobility and is not confining

Say uses a wheelchair

the person’'s limbs were cut off like a tree

Suffers from, sufferer — People with
a disability do not necessarily suffer

Say is/has... (the disability)

Victim — People with a disability are
not necessarily victims and usually
prefer not to be perceived as such

Say is/has... (the disability)

Disabled/other Olympics

Paralympics

Normal Paralympics

Olympics
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Logo

1l

The main identity for World
Wheelchair Rugby is illustrated
here. The bespoke letterforms
draw inspiration from the players
interacting and navigating
across the court. It expresses
speed, power, movement and
action.

The logo and its defined
relationships must never be
altered or modified in any way.

World Wheelchair Rugby

NN\N]  VNNNE

World Wheelchair Rugby

World Wheelchair Rugby

World Wheelchair Rugby

World Wheelchair Rugby
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World Wheelchair Rugby

World Wheelchair Rugby




Spacing & Sizing
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The World Wheelchair Rugby logo
looks best when surrounded by

a safe zone to protect its integrity.
The clear space is determined by
the thickness of the vertical lines.

The logo can be reduced, but
shouldn't be less than 2 inches
or 150px in width. If the logo is

reduced beyond the minimum size,

it will lose legibility and won't print
or display clearly.

The small-use logo accounts for
more open spacing and should
only be used at 2 inches in width
or smaller. The small-use logotype
should never appear less than

1.5 inch or 120px in width .

Minimum spacing

World Wheelchair Rugby

Small-use minimum spacing

World
Wheelchair
Rugby

Minimum sizing

N\\N\]

World Wheelchair Rugby

2 inch or 150px

Small-use minimum sizing

World
Wheelchair
Rugby

1.5inch or 120px



Licensing Logo
Spacing & Sizing
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Follow the guidance on this page
when using the licensing logo.

The Licensed by World Wheelchair
Rugby logo looks best when
surrounded by a safe zone to
protect its integrity. The clear
space is determined by the
thickness of the vertical lines.

The logo can be reduced, but
shouldn't be less than 2.25 inches
or 165px in width. If the logo is
reduced beyond the minimum size,
it will lose legibility and won't print
or display clearly.

The small-use logo accounts for
more open spacing and should
only be used at 2 inches in width
or smaller. The small-use logotype
should never appear less than

1.85 inch or 135px in width.

Minimum spacing

Small-use minimum spacing

Licensed by
World
Wheelchair
Rugby

Licensed by World Wheelchair Rugby

Minimum sizing

Licensed by World Wheelchair Rugby

2.25 inch or 165px

Small-use minimum sizing

Licensed by
World
Wheelchair
Rugby

1.85inch or135px



Logo Don'ts
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The uses illustrated here should

be avoided when using the World
Wheelchair Rugby logo. Failure

to adhere to these guidelines will
result in inconsistencies and create
confusion within the brand.

Don't set the logo in any colour other
than the brand colours as outlined in
this document.

World Wheelchair Rugb

Don't place graphic elements too
close or on top of the logo.

World Wheelchair Rugby

Don't change the relationship between
elements or create new lockups.

Don'tinvert or mask logo elements
with photography.

Don't rotate or flip the logo.

Don't add any transparency or effects to
the logo. It must be set at 100% opacity
in brand colours.

World Wheelchair Rugby

Don't adjust the dimensions
disproportionately, or stretch the logo.

Don't set the logo over busy
photography, or backgrounds
similar in tone.



Logo Positioning
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When creating collateral it is Bottom left
important to use a layout grid
to arrange all components.

The World Wheelchair Rugby
logo looks best when aligned to
the right edge of the page. We
recommend positioning this logo
in the top or bottom right corner.

When featuring the logo at a large
scale, it should fill the format width
from the left to right edge and sit
within the defined margins.

World Wheelchair Rugby

Bottom right

World Wheelchair Rugby

Full width

World Wheelchair Rugby



Co-branding
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In situations where World
Wheelchair Rugby appears
locked-up with other logos, this
page and the following page
should be closely referenced for
sizing and proportions in relation
to each other and the separator.

It's advised to display both brands
as one colour to ensure a balance
between the logos is maintained.

Lock-up spacing
Brands with equal prominence

World Wheelchair Rugby

Lock-up spacing
Brands with equal prominence

VR

World Wheelchair Rugby




Co-branding 17

Lock-up spacing
Brands with secondary prominence

moliten

World Wheelchair Rugby World Wheelchair Rugby

N\N\R] ACADEMY

World Wheelchair Rugby
Hogan
Lovells The official World Wheelchair Rugby Academy logo. Devised 3 July 2025.




Colour Palette
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World Wheelchair Rugby has Primary colours
three primary brand colours:
electric red, black and light grey.
These colours work well together
and can be used interchangeably.

The secondary brand colour 'digital
accessible grey' should only be
used in digital applications when
the primary colours do not meet
accessibility requirements.

When applying a brand colour to
the background ensure it fills the
frame.

Black

Pantone Black
CO MO YO K100
RO GO BO

HEX 000000

Light Grey

Pantone Cool Gray 2 C
Pantone Cool Gray 2 U
C14 M12 Y11 KO

R239 G239 B239

HEX efefef

Secondary colour



Richard
FF4035


Colour Combinations
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Colour should be used flexibly to
create variation and visual interest
across applications.

When applying colour to official
WWR documents, use the following
colour coding for the document
covers.

Technical and Competition
Document Covers:

Electric red background
Black or light grey text

Classification and Office/General
Document Covers:

Black background

Electric red or light grey text

Development and Medical/Anti-
Doping Document Covers:

Light grey background

Black or electric red text

Document covers colour combinations

Document covers:
— Technical
— Competition

Document covers:
— Classification
- Office/General usage

LACK
ELECTRIC RED

Document covers:
- Development
— Medical/Anti-Doping



Typography
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World Wheelchair Rugby uses two
brand typefaces:

Primary Typeface - Night

This is the brand signature typeface,
full of character and personality.

It should always be setin uppercase
and used for headlines on marketing
and promotional materials.

Secondary Typeface - Regola Pro
Regola Pro has contemporary
geometric characteristics that
compliment the logo and primary
typeface. It should always be set in
sentence case and used for intro,
body copy and small print.

Note: In corporate communications,
such as internal documents and
stationery, Regola Pro can also be
used for headline copy.

Primary typeface - Night

ABCDEF GHIJKLMNOPQ
RSTUVW.XSE
HS£6a

12335678901

Secondary typeface - Regola Pro

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijkimnopgrstuvwxyz
12345678901?#3¢L&@



Primary Typeface
Settings
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The primary typeface for World
Wheelchair Rugby is Night from
Type Department
(type-department.com).

Night Display is a minimalist
font that is used to create a
modern and fresh energy. The
round letterforms and sweeping
lines tie back to the distinct
characteristics of the logo.

Settings

The type setting guidance has
been carefully defined to ensure
the tracking and leading is equal
to the typographic counters.

It's important to follow the type
setting guidance on page 22 to
ensure type is always legible
and displayed in its best light.

Ensure Night is always set

in uppercase and used for
headlines only. Aim for headline
copy to run across a maximum
of three lines.

Tracking

HEADLINES
SET IV NIGHT

Type size Leading Tracking




Primary Typeface
Settings

22

Large headlines

100pt/133px and above
Night Variable Custom 900
Leading 72%

+10 Tracking

Medium headlines

Between 99pt/132px and 30pt/39px
Night Variable Custom 850

Leading 74%

+9 Tracking

U

LIN
NE

A SMALL
THREE LINE
HEADLINE

Small headlines
29pt/39px and below
Night Variable Custom 800
Leading 76%

+16 Tracking



Secondary Typeface
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The secondary typeface for World
Wheelchair Rugby is Regola Pro
from Think Work Observe (t-wo.it)
and comes in a range of weights for
print and web.

This typeface should always be
setin sentence case and used
primarily for intro, body copy and
small print.

Regola Pro has contemporary
geometric characteristics that
compliment the headline
typeface 'Night'.

Settings

The book weight is used for
headlines, body copy, small copy
and photograph credits. The bold
weight is used for subheads and
highlighted copy. Regular and
Medium are not currently used
within the brand.

Note: In corporate communications,
such as internal documents, Regola
Pro can also be used for headline

copy.

It's important to follow the type
setting guidance on page 24 to
ensure type is always legible and
displayed in its best light.

Regola Pro

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijkimnopgrstuvwxyz
12345678901?#3¢L&@

Book ABCDEFGHIJKLMNOPQRSTUVWXYZ ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijkimnopgrstuvwxyz abcdefghijkimnopqgrstuvwxyz
12345678901 ?#$¢L¥E€XK@O® 1234567890!1?#$¢£¥€%&@O®

Bold ABCDEFGHIJKLMNOPQRSTUVWXYZ ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijkimnopgrstuvwxyz abcdefghijkimnopqrstuvwxyz
12345678901?#$¢LE¥ €% X@O® 1234567890!?#$¢£¥€%E&@O®



Typography
Hierarchy

Headline

Night Variable Custom 850
55pt over 40.7pt

+9 Tracking

Uppercase

Note: Aim for headline copy to run
across a maximum of three lines.

Intro/Subheading
Regola Pro Book
21 ptover 22 pt
-25 tracking
Sentence case

Body / CTA / Subheading
Regola Pro Book or Bold
9.5pt over 12pt,

-10 tracking

Sentence case

Small

Regola Pro Book or Bold
7.5pt over 9.5pt,

-5 tracking

Sentence case

THIS IS AN
EXAMPLE OF
A HEADLINE

This is an example of
a two-line intro copy

Body, lorem ipsum menet aut et utem re, estis acerum ipsa que
corehendis magnia pratis niet remporem facius et que imagnimus
nam veligni mus trupta dendae. Piduntius nus quatium, optae
omnimpor maharum quatus aut nonse nihitis eicitaquam venit.

Small, andaectem es eum, quat aut post anis dolupti assit,
inis into ipsunt abor atiate cuptatiani cum, quam fuga.
Nam ea doloria conseribust est, odicia con cus aut cusam,
sin nit laceserrum, sunt voluptat asitaqu atibusandae nim.

This is an example of a CTA
or subheading

This is an example of highlighted
text within the small type style.



Typography
Substitute Fonts
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The unique characteristics of
Night and Regola are imperative
to World Wheelchair Rugby's
look and feel, and should be
used whenever possible.

The chartillustrated here shows
when to use the substitute

font Arial.

Website

NIGHT Regola

Advertising

NIGHT Regola

Marketing materials

NIGHT Regola

Internal applications (static graphics)

NIGHT Regola

Internal applications (live type)

Arial

Stationery

NIGHT Regola

Stationery (body copy only)

Arial

PowerPoint presentations (public)

NIGHT Regola

PowerPoint presentations (internal)

Arial

Employee e-mail and signature

Arial



Typography
Colour
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Use the guidance on this

page when applying colour

to typography. Always ensure
type is set in a brand colour that
provides sufficient contrast with
the background.

For communications that are
copy heavy, primarily use

black type on a white or light
grey background to ensure
maximum legibility. Use a single
contrasting colour for headings,
subheadings and pull-out

copy to draw attention to this
information.

Do not apply more than two
colours to typography on one
page.

When applying colour to official
WWR document covers, please
follow the colour guidance on

page 19.

Background: Black
Type: Electric Red or Light Grey

Background: Electric Red
Type: Black or Light Grey

World Wheelchair Rugby

imi, offic

Copy heavy
Background: White or Light Grey
Type: Black or Electric Red

Inner Page Title
Goes Here

LOREM IPSUM NAM res voloriae plate consequi ulparun tisciistio. Et est ipid
mo et aut etusanihil inulpa simolup taturio ex eaquia dolores tiorrum reni blam
haruptijum, in pro ium quis volupta erumqua tquamus mi, sita sam Apita con-
sende parcimus et pedi od quidici odit aribusaniet harchil ipic tenimin et erunt,
quos eum quassitet exero officil idessim inulpa animeni squodi to cone porepe
poreribus re es maiorec ulparum eost,id quas des esequiate odia quae alia
que eum quiam dolupti aturisciis cullam, ommolectiae. Net alias porem que et
qui ditasint, cuptati ad. Niandae dolores aut etusa cupta vellorit velit fugia paris
cupti asi quaes rem facipsa ndamusdamus dolo dio ipsusdam serum, simusci
ationsecaest vollaccuptur.

Vit post, conserum fuga.

Dellatetus vid quamet maximaionen es repe core vellant emolend itibusam, od
etque ea nob dolorum g dam qui alitio blaut esequiatia
assit qui as voluptat exerspe lluptae plit quamenit, accus iunt que archilis eos et
eumaqui torum, esti officiendit, occuptibus.

Nnullupi ciisquiam et lia sum qui il magnat everspi enihitatur, simus doluptur,
unt omnihil lessit auditat voluptae s eici re earuntia nonsequae audit autes et
periorero inciet accate pratiis rem ullis rem ut alibus, is dignis et harumqu atem-
quatis volupient Hicatur simus volut doluptas alitiorerum quam, omnis estiste

“Net alias porem que et qui ditasint, cuptati ad dolores
aut etusa cupta vellorit velit fugia paris cupti asi quaes
rem facipsa ndamusdamus dolo dio ipsusdam serum,
simusci ationsecaest vollaccuptur.”

ellore rempediscim adi quidempore pedicient emam quiandam ut quianduntur
reped quis mi, odi bla aut modi dolor maximusanto berchil et licae mo eius que
vent ut od que comnis alia asperio con eatemperest, eictae peliquisi nobis pa
nem sit ulparum essincia cusciet, offic temaue. Litiur?

Ro eossi sequodit auda sitates equunt qui si vere pori ates vendandelis vella pe
oditius anihil exeritio cus del ilibus, nonsequis as rescienisque sinctum voles a
dolor sus ut it il liquam nonsento molupta tiuria venducilin estin non reptae plis
maiorem nus, et audi nonsequisin nectusae.

Ipis aut ration evelent et vernate mporectur rerrumq uiamus modi del molore-
heni de qui omnis imus, ipsapit ea dem fuga. Dunt dolestissum facea volor rem
estius eum cusdamusae volupiet qui blaboria voluptaes etur andel ipsapelecta
que dolorum re nobis dolenitatium qui quate volutem quatem qui core
atur sam dolest quasper feruptatur aut rero modis maxim volorro quis ute volup-
tat molorrum, voluptas idiatem es coremodi comnimint pe iusandent, nemodis
eossimus secus voluptatur am, quosae. Nimusdae nimpos nis enimin ea
volorum ilignat urerem. Post, quosanti dolestem fuga. Ut alit, quibus idem re cum
dolorestiis nisim quo bea consequas aperia prorempedis inum, audaectas sit ut
ma volorrum lab ipit, qui cum voloreptis dolorem poresendio. Uptatur enihit, si
reped que re volupta tiumque cum ipsae nempore pelesti offictat molendamus.




Photography
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Where possible, always prioritise Black and white
black and white photography to

enhance the emotion and drama

of the image.

External communications such as
posters and billbooards should always
feature black and white photography.

Internal communications or
applications with multiple pages
should use black and white
photography for feature imagery,
and colour photography can appear
throughout internal pages.

Allimages should be authentic,

so never put an image of an able-
bodied person in a wheelchair.
Exceptions to this rule may occur
when showing the Invictus Games,
VIP events, promotional opportunities
or development activities involving
schools or family members.

Colour



Photography
What to Shoot
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Use the following guidance to Mid-action
ensure imagery captures the brand
characteristics:

Brand imagery should feel authentic
and feature the intense athleticism and
excitement of the game.

Capture in the moment, mid-action,
shots that convey the energy and skill
of the sport.

Feature tough, fearless facial
expressions that communicate the
determination and intensity of the
players.

Always ensure the wheelchair is visible
and never crop out the disability.

A single image should include all of the
above photography characteristics. If
multiple images are displayed on one
page, the characteristics can be visible
across the set of images.

Stock Imagery

For unique, ownable imagery always
aim to commission a photographer.
If stock imagery is needed, ensure
it's authentic and follows the brand
photography requirements.

Images used for reference only.
Image credit: Getty Images & ESPN

Intense facial expressions



Photography
How to Shoot It
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Use a fast shutter speed to capture
the motion and a dynamic viewpoint
to accentuate the movement and
angles of the players.

Ininstances when there is a busy
background, experiment with depth
of field and open the aperture to
focus on the subject.

Shoot in colour, as images can be
edited afterwards. For image editing
guidance please see the following

page.

Image used for reference only.
Image credit: leesfoto.net




Photography
Image Editing
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Black and white

To enhance the emotion and drama
of the image, convert it to black

and white. This technique allows the
viewer to focus on the subject, scene
and textures in the image without
being distracted by the colours.

In Photoshop, select Window >
Adjustments, then click the
Black & White icon. Drag the
sliders left to darken and right
to lighten the tones.

Levels

If further image editing is required,
select Window > Adjustments, then
click the Levels icon. The levels tool
enables you to adjust the brightness,
contrast and tonal range of the
image. This will help to adapt the
shadows, midtones and highlights in
the scene to make it more compelling.

Noise

To reduce imperfections in stock or
shot photography, add a subtle grain
effect. This treatment will also create
cohesiveness across compositions.
Select Filter > Noise > Add Noise.
Ensure this effectis set to
'Monochromatic' and is subtle enough
to not distract from the subject.

Black and white Levels Noise




Photography
Image Cropping

Wheelchair rugby games and events
often have busy backgrounds that
create visual distractions.

Photograph wider shots and then crop
in closer afterwards. Crop the imagery
to reduce background noise and focus
in on the main subject, action and
facial expressions.

Avoid capturing shots that feature the
back of athletes bodies and ensure at
least one athletes face is in the frame.

Always ensure the wheelchair is visible
and never crop out the disability.

Images used for reference only.
Image credit: ESPN

Photograph: ESPN



Photography
Image Credit
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All external communications should
feature an image credit.

The image credit should be
positioned in close proximity to the
photograph. If this is not possible,
position the image credit directly
above the photograph in the top or
bottom left corner, whichever location
provides sufficient clear space and
contrast.

The image credit should always
feature the image rights holder
and follow this naming convention
example:

Photograph: Getty Images

In instances when a specific athlete
is featured, the image credit should
follow this naming convention
example:

Photograph: Trevor Hirschfield/Getty
Images

iPh,o.t.ogr.a ph: Aaron Phipps/WWR

Typography:
Regola Pro Book

Size:
Image credit should be the smallest type
element on the application and appear
discreet yet legible.

Colour:

Set type in a brand colour that
provides sufficient contrast against
the background.

Positioning:

Position the image credit in the top or
bottom left corner, whichever location
provides sufficient clear space and
contrast against the photograph.

If a corner of the photograph does not
provide clear space to position text
legibly, lighten or darken the image
area in Photoshop.



Photography
Image Examples

33

The images displayed here follow the
photography guidelines and capture
our brand characteristics.

To view the image library please
click here.

To view the video library please
click here.

WWR_Image_1.jpg

WWR_Image_6.jpg

WWR_Image_11.jpg

WWR_Image_16.jpg

WWR_Image_2.jpg

WWR_Image_7.jpg

WWR_Image_12.jpg

WWR_Image_17.jpg

WWR_Image_3.jpg

WWR_Image_8.jpg

WWR_Image_13.jpg

WWR_Image_18.jpg

WWR_Image_4.jpg

WWR_Image_9.jpg

WWR_Image_14.jpg

WWR_Image_19.jpg

WWR_Image_5.jpg

WWR_Image_10.jpg

WWR_Image_15.jpg

WWR_Image_20.jpg


https://www.dropbox.com/sh/azzsueeegnhbw2r/AAAnnZGk420t28scBhcLwSeXa?dl=0
https://www.dropbox.com/sh/frf20vi6b5om22i/AAAnbsT9YA-LjI-bpWie_JKAa?dl=0

Photography
Image Examples
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The images displayed here follow the
photography guidelines and capture
our brand characteristics.

To view the image library please
click here.

To view the video library please
click here.

WWR_Image_21.jpg

WWR_Image_26.jpg

WWR_Image_31.jpg

WWR_Image_36.jpg

WWR_Image_22.jpg

WWR_Image_27.jpg

WWR_Image_32.jpg
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WWR_Image_40.jpg


https://www.dropbox.com/sh/azzsueeegnhbw2r/AAAnnZGk420t28scBhcLwSeXa?dl=0
https://www.dropbox.com/sh/frf20vi6b5om22i/AAAnbsT9YA-LjI-bpWie_JKAa?dl=0
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Image Examples
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The images displayed here follow the
photography guidelines and capture
our brand characteristics.

To view the image library please
click here.

To view the video library please
click here.

WWR_Image_41.jpg

WWR_Image_42.jpg

WWR_Image_43.jpg

WWR_Image_44.jpg

WWR_Image_45.jpg


https://www.dropbox.com/sh/azzsueeegnhbw2r/AAAnnZGk420t28scBhcLwSeXa?dl=0
https://www.dropbox.com/sh/frf20vi6b5om22i/AAAnbsT9YA-LjI-bpWie_JKAa?dl=0
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Do's & Don'ts
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Follow the guidance illustrated
here to ensure all imagery captures
the World Wheelchair Rugby brand
characteristics.

Don't use images that are out of focus.

Do ensure the subject is always
in focus.

World Wheelchair Rugby

Don't crop out the wheelchair.

Do ensure the wheelchair is visible.

Don't crop out the disability.

Do use authentic images of athletes
and ensure the disability is visible as
it's part of the players and the sport.

Don't feature static shots that lack
movement, energy and excitement.

Do use mid-action shots that feature
the intense athleticism and excitement
of the game.



Photography
Do's & Don'ts

Follow the guidance illustrated
here to ensure all imagery captures
the World Wheelchair Rugby brand
characteristics.

Don't use animage where the faces are Don't feature subdued facial Don't use busy images that have no Don't use placid shots of the players
obscured and no expression is visible. expressions that lack emotion clear point of focus. that lack energetic body movements.
and intensity.

Do ensure at least one players face Do use tough, fearless facial Do have a clear point of focus that Do use in the moment shots of the
is visible to capture the emotion of expressions that communicate directs the viewers eye to the subject. players that feature expressive body
the sport. the determination and intensity movements or skillful wheelchair

of the players. angles.



Photography
Do's & Don'ts
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Follow the guidance illustrated
here to ensure all imagery captures
the World Wheelchair Rugby brand
characteristics.

Don't use full colour photography
for the primary image on external
communications.

Use black and white photography
as the primary image on external
communications.

Don'tincrease the levels too much
so that the image becomes too dark,
gloomy and unidentifiable.

Do follow the guidance on page 26
to adjust the brightness, contrast and
tonal range of the image.

Don't decrease the levels too much so
that the image becomes too bright with
strong contrast.

Do follow the guidance on page 30
to adjust the brightness, contrast
and tonal range of the image.

Don't add too much grain effect/noise
so that the texture detail overpowers
the image.

Do use a subtle grain effect/noise
that reduces visibility of any image
imperfections.



Graphic Pattern
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The bespoke World Wheelchair
Rugby logo is created from
dramatic shapes that portray
movement on the court.

Crop into a section of the logo
to create an engaging graphic
pattern.

Always crop a section of the
letter to create an abstract
pattern, do not feature a

full letter.

This pattern can be used to add
visual interest to applications.
Please see examples on the
following page.

Large crop Small crop

Crop examples

‘1 Ne N\



Graphic Pattern
Examples
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Always ensure the graphic
patternis appliedtoa
contrasting brand background
colour. The pattern can be
used full bleed or within the
document margins like the
examples opposite.

World Wheelchair Rugby

QL 0V HEELCHAIRRUG M -

lworldwheelchairrugby

worldwheelchairrugby Here to win.

lworldwheelchairrugby







Poster

Colour palette
Red, black and light grey
used in a complimentary way.

Headline
Night Variable Custom 850
setin uppercase for headlines.

Intro copy
Regola Pro Book setin sentence
case for intro copy.

Lorem ipsum nam res voloriae plate
consequi ulparun tisciistio.

Small copy
Regola Pro Book setin
sentence case for small copy.

quitem voloris.

Photography

Facial expression communicates
the determination and intensity
of the sport. Black and white
treatment enhances the emotion.

Logo positioning
Bottom corner aligned to the
right edge of the format.

Photo credit

Regola Pro Book set in sentence case.
Athletes name and photograph owner
positioned in left corner where clear
space allows.




Report Cover

Small copy
Regola Pro Book set in
sentence case for small copy.

Graphic pattern

Large crop of the logo featured
as a graphic pattern to add
visual interest. Pattern aligns to
margins.

January 2021
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Code of Conduct

& Best Practices

Headline copy

Regola Pro Book setin sentence
case for headline copy on
corporate material.

Colour palette
Red, black and light grey
used in a complimentary way.

Logo positioning
Bottom corner aligned to the
right edge of the format.
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System Templates

‘World Wheelchai Rugby

Agnseyoles

‘World Wheelchai Rugby

Code of Conduct
& Best Practices

fd Wheelchalr Rugby

Code of Condu
& Best Practices

AqBnseyoleayn

This is a Section
Heading

This is a section intro. Int, tes et quia
sequia vel eum, solorib erspita ssequi
dolorem pellauta volorem posseque
essitat fugia ipis re nihit quam quae
porrunte niscimaio bea porum arciligeni
quae et re, nonsequid maio. Itaquis
sinullabor rerspit dis ad molupta ssequi
arumende pellabo. Ro vellat lacesequam
volorios adit at esti simincit, et expliqui
iurionem et voluptat.

This is a Section
Heading

This is a section intro. Int, tes et quia
sequia vel eum, solorib erspita ssequi
dolorem pellauta volorem posseque
essitat fugia ipis re nihit quam quae
porrunte niscimaio bea porum arciligeni
quae et re, nonsequid maio. ltaquis
sinullabor rerspit dis ad molupta ssequi
arumende pellabo. Ro vellat lacesequam
volorios adit at esti simincit, et expliqui
iurionem et voluptat.

Photograph: Deseription

Lorem ipsum re est,inciet
restiorerum,is eaque volecturio
doluptiipicatem et doloreri que.
repudi cus nimi, officta speri-
oratautaliquod isinver feribus
‘escium, qui tem voloris mag-
natin evellaborrum.

Ebit porpora nonseque eum aut
exerumgui ommolor ibeaquam
vitem et ium solume maion
repelit lat doluptur, nonsed quae
cum quo dolupta taspiss equodi
officiis dio. Nam, utectustrum
event repudis a quationem vel-
landitium ipsam dolum ut aruntio
tem voloratis dollorerit eaquis
ex et accumquat veris dit deb-
itiisit vid magnis mollant, sit odi
doloriasped quae que volupta

ectur, cus as aut a nobitis pellabo.

Et vent ratis el inverci piend.
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System Templates

Document Intro
Title Goes Here

LOREM IPSUM

il magnat

Etostipid mo etaut

dolores tiorrum reni blam harupti um, in pro
ium quis volupta erumqua tauamus mi,sita
sam Apita consende parcimus et

audit autes et periorero
inciet accate pratii rem ulls rem ut alibus, is
dignis et harumqu atemauatis volupient

quidicl odit aribusaniet harchilpic tenimin et
ides-

Hicatur simus volut doluptas altiorerum
a discim adi

erunt, m,
sim ut
s id q ped quis mi,odi bla aut modi
licae mo eius
Jec-
tize. Vit post, Dellatetusvid  eatemperest, nobis pa nem
fic te

a
emolend itibusam, od et que ea nobitae.

Litiur? Net alias porem que et qui ditasint,
a d.

uptatia tetusa cupta

plit it
archilis eos et eumqi torum, esti offiiendit,
‘occuptibus, nullupi cilsquiam et lia sum qui

serum, simusdl ationsecaest vollaccuptur,

1 Lorem psum nam es volorae iate conseqululparun tsclisto.

Inner Page Title
Goes Here

LOREM IPSUM NAM RES voloriae plate con-
sequi ulparun tsciistio. Et est pid mo et aut

que vent ut od que comnis alia asperio con

dolores tiorrum reni blam harupti ium, in pro
ium quis volupta erumqua tauamus mi,sita

eatemperest, sictae peliquisi nobis pa nem
sit offictemaque.
Litiur? Net alias porem que et qui ditasint,

cuptati ad. Niandae dolores aut etusa cupta

harchil pic tenimin

idessim inulpa animeni squodi to cone.
porepe

mi. Vidiorit et quiate solor re, tem et ent,
l end

eost,

fuga. Faccupt

ommolectiae.

Vit post,conserum fuga. Dellatetus vid
‘quamet maximaionem es repe core vellant
emolend itibusam, od et que ea nobitae.

officlinum, X
nempori des et et etur sinihi estinvelia ipsus
volorpo roresciae saepellorepe volorem
quaepudant.

Untfuga. Itat Retem fugita quatur aut que

alitio blaut

costibust,

poritat i, aborre voluptat

pli it
archilis eos et eumqui torum, esti officiendit,
o

maximilim utem. tatum rest, que autemaui

non nonsequar ittt
libus aut molo et minctur? Qui

ptaeis eicire

inciet accate pratis rem ulls rem ut alibus, s

audidoluptat et

dignis et

tiume evendae natem explia non reri non

Hicatur i
quam, discim adi

it rerum

ut
quianduntur reped quis mi, odi bla aut modi

blaboreria nemporuptae rem verum even-
dipsum

6 Loremipsum nam es voorias plte consequi uiparun tiscsto

Inner Page Title

Inner Page Title
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Inner Page Title

Goes Here Goes Here Goes Here
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harupt Jum, in pro ium quis volupta erumaua tquamus mi. ita sam Apita con- haruptium, in -
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quidempore ipsusdam serum, simusci ationsecaest vollaceuptur.
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maiorem nus, et audi nonsequisin nectusae. Et estipid mo et aut
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exerspe lluptae piit quamentt accus iunt que atursam dolest P d pliberrum vel eaqui a volore eum eatimin conseque it voluptae. Et iciaspit
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occuptibus. m, quosae. Voluptat lissunt Ia ruptist
Post, Utalit, quibus idem re cum emquam
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omnihillessit auditat voluptae is ici e molendamus. sitatem. Ut facea nus et etur molestrum eosame deliber spedion
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A4 Letterhead

Recipient address
Cossette, 32 Atlantic Ave
Toronto ON Canada M6K 1X8

worldwheelchair.rugby 4 Park Square
info@worldwheelchair.rugby Newton Chambers Road
+44 (0)114 257 3170 Sheffield, England S35 2PH

World Wheelchair Rugby
April 01,2021

Dear John Smith

Dolor plissus re odio imodiscitas consequi num nam, opturesed quatiat aut
dolenis aut que eaquasitio es re que earci audi doll est rumqui deles doluptur
vidioremolor soluptam dolor est vitassitem et haris et quam volendende eum
iunt ea vernat.

Icte dolorpor sit et mi, et arit volupta quis maximpore volo exername

lor quia quo tem poreium alibus aut laborent optatempor alit ratessi lorem
ea aspera consed quis res. Sum ducidit officil iur, officip sunest dol tet pedit,
tem natem exerfero cum quae cum siminve rionec tia dit, officimaio vernam
doluptatem corrum nisquis quod etur aboreium.

Si untecuptaqui ut es essequiae odi aut fugitata sim faccull uptatur lorem
max dolo rest imus est, qui ius et, optas adignam ustiorument harios ipsum
et, sitecepudi optat es et etur sit untota quam vel idiciis aut as ditia dolor
maximporerum dolenimus renden lorem ipsum dolo da dolorit, non lorem
sentur, simoluptam, con empo repudae dis ma es rate nam quis qua omnient
sinc imporro tem ipsunt, sus aut atque perum fugiasp ernatur. Ellaudis eium
facerferisci quis excest parunt eius earibust, simet, cum doluptas dis eum

ex esequi aut erovitae quae eum, untia qui officim dolore pe pra dles est
luptatque pa quam omnient quod earupta musant mi, excepe et rehend
untiam eriae debis dio.

Que eaquasitio es re que earci audi doll est rumqui deles doluptur est dolor
vidioremolor soluptam dolor est vitassitem et haris et quam volende lorem
nde eum iunt ea vernat.

Yours Sincerely

Name here

Registered Office: c/o World Academy of Sport, Switzerland Sarl, Route Suisse 8A, 1163 Etoy.
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Email Signature

To whom it may concern,

Aborro optam quodita tectur si nectaquist et et maion ent as ente poressi musdame quia pende
storem erem que re qui dolorepro quidis autatemquam sam id experfero tecat.

Sapis rempos eum sitibus etur, qui seria consecat aut fuga. Itam quo dolorer spellecae comnis
illiquis aliquodi omnim fuga. Ebit facest ut que venimet inusdan dellam, qui nus et aut aligeni
hiciliqui doluptat hicitatium eaque esti rerum id molupta tiorpor ehendant autem venihitae.
Name volorec ationse verro eaquiantem fugia verovitis asimus della quae reperferion re dolor
ep udandis as re, simendero dolendi.

Ommoluptatem entiat. Rovit faccum non re doluptasit fugiam non nobis pa inis et ea dolupitam
et quodi non natasse quundio eaquam verrovit dolor aut perae non re, quaepedit veliquos del
imus estes vidi cor sant accatia veris sintibus, que aut velenitas moluptiberum id que ma voloria
cus aligenimin porrum quosant a into bea et laudisque sunte volupta tioriberi dolupta explam
voluptate vero eventiaspel idelia sum alic te laborpore pa conseque cum etum cullam, odictotate
dolupta temolor alit, quatem fugia pre sum excepre maximint.

Regards,
Richard

Richard Allcroft
President

Tel: +44 (0)7977412272

Email: rallcroft@worldwheelchair.rugby
Skype: richard1234321

Facetime: rallcroft@worldwheelchair.rugby

worldwheelchair.rugby
Instagram Facebook Twitter YouTube

World
Wheelchair
Rugby

This email and any files transmitted are confidential and intended solely for the use of the individual or entity to which they are addressed. If you have received this email
by error, please notify us immediately and permanently delete it from your computer.

New Message

To:
Cc/Bcc, From:
Subject:

To whom it may concern,

Aborro optam quodita tectur si nectaquist et et maion
ent as ente poressi musdame quia pende storem
erem que re qui dolorepro quidis autatemquam sam
quosant a into bea et laudisque sunte volupta tioriberi
dolupta que re qui dolorepro quidis autatem.

Regards,
Richard

Richard Allcroft
President

Tel: +44 (0)7977412272

Email: rallcroft@worldwheelchair.rugby
Skype: richard1234321

Facetime: rallcroft@worldwheelchair.rugby

worldwheelchair.rugby
Instagram Facebook Twitter YouTube

World
Wheelchair
Rugby

This email and any files transmitted are confidential and intended solely for the use of the
individual or entity to which they are addressed. If you have received this email by error,
please notify us immediately and permanently delete it from your computer.

Cancel

To:

Cc/Bcc, From:

Subject:

To whom it may concern,

Aborro optam quodita tectur si nectaquist et et maion
ent as ente poressi musdame quia pende storem
erem que re qui dolorepro quidis autatemquam sam
quosant a into bea et laudisque sunte volupta tioriberi
dolupta que re qui dolorepro quidis autatem.

Regards,
Richard

Richard Allcroft
President

Tel: +44 (0)7977412272

Email: rallcroft@worldwheelchair.rugby
Skype: richard1234321

Facetime: rallcroft@worldwheelchair.rugby

worldwheelchair.rugby
Instagram Facebook Twitter YouTube

This email and any files transmitted are confidential and intended solely for the use of the
individual or entity to which they are addressed. If you have received this email by error,
please notify us immediately and permanently delete it from your computer.
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PPT Template

Image

Photograp: Atlete rame/Pholographer owner

Image

Photograpt Athiets rame/Photographer owner

Presentation
Title

Section Title

Image

Photograph: Aete name/Phalographer owner

Presented by First Last Name
April 01, 2021

World Wheelchair Rugby

Body copy. Ma quunto blacere hendanis dis etur, te
necto dolorem. Pore sitatur acepedi to qui con cus
nonsequatus erenimus dolut asperfero quunt adiae

Apri 01, 2021 Word Whesichar st

Section Title

Presentation
Title

Section Title

Presentaton Tt

Image

Photograp: Atlete name/Pholographes owner
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Presented by First Last Name
April 01, 2021

World Wheelchair Rugby

Body copy. Ma quunto blacere hendanis dis etur, te
necto dolorem. Pore sitatur acepedi to qui con cus
nonsequatus erenimus dolut asperfero quunt adiae.

gl 01,2021 Wk Wheokhar sy

Section Title

April01, 2021 ki Wheskhat Rugby
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World Wheelchair Rugby

Dear WWR Member Nations,

The WWR President and the CEO are hosting a video conference all using
www.zoom.us for all Member Nations on Monday 29 March 2021. Members
can join for one of two calls at 9am or 9pm UK time.

A maximum of two participants can join the call. A third individual will be
allowed if they are an interpreter. The call will take place in English. The video
call details are included in the attachments.

The call will start 15 minutes before the scheduled time to allow individuals
to join.

Please find attached the following documents:—

— Meeting agenda

- Briefing paper on proposed governance revisions which will be a principal
agenda items for the general assembly.

— Meeting joining details

Many thanks
Steve Giriffiths
CEO

worldwheelchair.rugby Twitter Facebook
Instagram YouTube

World Wheelchair Rugby

Want to change how you receive these emails?
© 2021World Wheelchair Rugby You can update your preferences or unsubscribe from this list
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World Rankings

Rank Points Team Rank
1 698 Australia 16
2 642 United States 17
3 636 Japan 18
4 457 Great Britain 19
5 409 Canada 20
6 360 France 21
7 348 Denmark 22
8 296 Sweden 23
9 265.4 Brazil 24
10 256.6 New Zealand 25
1 224 Germany 26
12 165 Colombia 27
13 153.4 Poland 28
14 130 Korea 29
15 109.8 Ireland 30

Special thanks to our sports partners
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Finland

Switzerland
Netherlands

Russia
Argentina
Thailand
Chile
Paraguay
Malaysia
India
Austria

Czech Republic

Israel
Italy

Spain

The World Wheelchair Rugby Federation
is the governing body responsible for
the sport of Wheelchair Rugby. First
established in 1993, the purpose of the

WWR is to help develop, promote, and
regulate the sport of Wheelchair Rugby
on a global basis. Learn more at
worldwheelchair.rugby/about us

worldwheelchair.rugby Twitter Facebook

Instagram YouTube
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For more information please contact

the WWR CEOQ, Steve Griffiths at
office@worldwheelchair.rugby

Board Director

Responsible for Finance

Are you here to win? Wheelchair Rugby is a sport like no other.
World-class athletes from over 40 countries compete in full contact
action that leaves an impression on anyone who sees it.

World Wheelchair Rugby (WWR) is not just a governing body, it's a
collection of passionate people that love the game and believe in
the virtues of competition, grit and above all - sportsmanship. We are
developing and putting in place strong governance with the goal of
sharing the sport with as many people as possible. With strong and
diverse leadership we will benefit athletes living with a disability as
well as their families in addition to the amazing volunteer base that
we rely on. That said, we aren't your average Para sport: Players and
teams don't play this sport to inspire, they play to win. Do you?

The role
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Deadline for receipt of interest: 26 February 2021
Interviews: 1 March 2021 (week commencing)
Board Meeting: 9 March 2021, 20:00 UTC
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The official World Wheelchair Rugby Academy logo. Devised 3 July 2025.
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